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Storybook Tips, Hints and Helps
July 2008

FYI:  CM's Storybook and Memory Manager Help Line is awesome! 866-440-2420

As I'm making pages, I find I use some of the same features over and over.  So I've decided from now

on to take notes and pass them on to you when I think it might help.  And now that we have our weekly

online trainings called "webinars", you get to see these demonstrated; which is great for scrapbookers! 

Just email me for the information of how to join in on those calls.

I will try to remember to indicate where on the screen to click.   If I don't mention it, it's usually

because it's on the main menu at the top of the screen.   On the lefthand side of your screen are the

elements (layers) of the page as you “build the page” and on the right hand side are the things to add to

your page:   photos, pages, shapes, papers or embellishments.   When I mention "clicking", I mean the

left click button.  I'll tell you when it's a "right" click.

MY FAVORITE THINGS TO KNOW  (not in any particular order)

Lock: When you want to work with a certain element, lock the other elements so that you won’t keep

moving the wrong thing.  The "elements" are on the left hand on your screen.  There's an eyeball that

you can click on to "hide" the element to see what the page would look like without it.  And below the

eyeball is a little paddle lock.  That's where you click to lock the element in place while you're working

with other parts of the page (elements).

Ctrl Z: works as undo (same as the button on the upper lefthand side of the screen). It's your best

friend!

Ctrl A: selects ALL with whatever you’re doing.  So if you’re in a text box, pressing Ctrl A

selects all the text so that you can easily change the font, size or color.    If you’re using Ctrl A on 

the whole page, it will select all the elements making it easier to shadow your elements on the 

page or to group them, etc.

Up, Down, Left, Right Arrows:  If you are wanting to move anything slightly up and down, right or

left, etc., simply have the item selected and use your arrow keys.

Magnify:  If you need to increase the size of the character(s) or items in the photo, you'll click on the

photo and on the right hand side, a blue magnifying ball will appear.   Grab that ball by holding down

the mouse and move it up.   The size will increase, then you'll need to move the photo around to have it

display what you want.  You can also do this with the Photo feature on the main menu and move along

the slider.   

Changing the Default Font for Text:   Click on Text, click on Text again and select Change default

font.  Now choose your favorite font, size and color.  You can also have it be bolded, italics, or

underlined and where inside the box to place the text.  The default is top center.  This will be the font

for any box that you create.   You can also choose Fancy and select from everyday, vintage and mod (if

you’ve purchased them) and have some really fun titles.
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Aspect Ratio

This is another feature that I can't live without.  This feature is accessed by right clicking on the photo

or any element, or by going over to the element on the lefthand side of your screen and clicking on the

down arrow.

Here's what I use:

• If you need to change a picture from landscape to portrait or visa versa.

• When you need to crop off the sides or top of the photo.  You unlock aspect ratio.  This allows

you to resize anything:  photos, paper, shapes, etc.  When working with a photo, you'll unlock the

aspect ratio, and then use your mouse to bring in the sides of the photo.  Once you have it the size

you’d like, use the mouse hand to recenter the photo and it looks great.  You can also magnify the

photo (mentioned above) and really zoom in on what you want to see.

• With the unlock of Aspect Ratio, you can expand any element in one given direction without it

expanding the whole photo, box, etc.   Just click on the photo, etc., then right click, click on

Aspect Ratio then click on unlock.  Now that it's unlocked you can drag any side of any element

and expand. 

• If you want to make a perfect circle with your photo:   First click on your photo, go to Photo, Mat,

Cutout and then select the circle shape.  Your photo will go into some kind of an oval.  Then

accept it.  Now right click on your photo and select aspect ratio. Then select Square.  Your picture

is now a perfect circle that you can resize.   You'll probably need to reposition the photo inside the

circle by clicking on the center of the photo and using the hand to move the photo around.

Matting Several Photos: If you want to mat more than one photo at a time, click on one of the 

photos, hold down the shift key and click on the other photos, or select them from the elements on the

left side of your screen.   With the photos selected, you can go into Photo, Mat.   Then select the size

and color.  (Below I explain how to matt a photo with paper).

Sample Color:  Speaking of color, when you want to match a shirt color, leaf, background, etc., when

in the select color for matting, fonts, hue, etc., click on the little dropper that says "sample color". 

Then go to item that you want to match, click on that and now you have the exact color.  It's magic.

Remember that if you're changing the color of your font, you have to select the text first (I like to do

that with Ctrl A).

Choosing another shape for your photo(s): Select the Photo(s) you’d like. Go into Photo, Mat,

Cutout then browse through the many shapes.  (The rounded rectangle can give a corner-rounded look).

Layout on the main menu: The layout tool is another best friend.  I simply size a photo the way I

want and when I want other photos to be the same size, I simply click on the first photo, hold down the

shift key and select the other photos making sure that the photo that is the size I want is the last photo I

select.  Then I go to Layout and select the icon in the lower left hand corner that says “make selected

elements same size as last as last selected element” and click on that and they’re now all the same size.  

The same thing works for the same height or width and to align with different parts of the page.   Just

make sure that the last photo you select is the example that you want to follow.
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To mat a photo that has been cut into another shape:   After cutting your photo into another shape,

go to the Shapes feature and select that same cutout.   Right click on the shape and select Cut out of a

piece of paper.   Now here’s the fun of digital scrapbooking– You get to cut that shape out of any spot

on that paper.  Click on OK.   Click on the shape you just created.  Now click on the photo cut out.  Go

into Layout and select the lower left hand corner to make the selected items the same size.   The paper

mat and photo are now the same size.  So reselect the paper box and drag it so it’s larger than the

photo.   (You’ll need to move the photo to the front to make sure it’s on top of the mat).    After you

have the photo and the paper mat, use the directions below called “Centering one element on top of

another.”

Centering one element on top of another:  Have you wanted to quickly center a photo (or paper) on

top of a mat or another piece of paper?   It’s a two step process. Click on the top layer, then hold down

the shift key and click on the bottom layer. Now go to the Layout tab and click on the second option

(center vertically) and then the fifth option (center horizontally). This should center the top layer inside

the bottom layer.    By the way, if your photo is some kind of shape (oval, circle, etc.) and you want to

make a perfect mat:  Go to Shapes and right click on the same shape as the photo.  Select Create this

shape and select the color, and then create it.  Now click on the photo, hold down the shift key and

select your shape.  Go to the Layout tab and click on the lower left side of “make selected elements

same size..”  Now select the shape again, drag it a little larger and follow the centering feature about.  

Matting regular square/rectangle photos with Paper: (This is the same process as matting the

photos that have been cut into shapes)   Click on Shapes from the right.  Right click on the square and

select cut this shape out of a piece of paper.   You’ll now be in the “cutting board” where you can

choose your paper and then position the square over the section of paper that you’d like.  You’ll notice

in the lower right hand corner, it’ll show you the dimensions of the box where you can then enlarge or

shrink it.   Click on OK to create the box.   Now select the paper box you just made, hold down the

shift key and select the photo you want to mat.   Go into Layout on the main menu and select the lower

left feature that makes everything selected the same size.  The paper mat and photo are now the same

size.  So reselect the paper box and drag it so it’s larger than the photo.   (You’ll need to move the

photo forward to make sure it’s on top of the mat).    After you have the photo and the paper mat, use

the directions above called “Centering one element on top of another.”

Vellum Journaling Boxes:   To put a piece of “vellum” behind text, you’ll select Shapes from the

right hand side of your screen.  Select the top one that says Square and get the shape you want and the

color (usually white) and Create it.   Then go into Tools and then to Opacity and lighten it up to like

75.   Then make sure that the text is on top of the box.  You can go to Tools to change the Color or

select Paper to cut the box out of a different paper pattern.   I also like to Blur the edges of the Vellum

box.   Make sure the vellum box is selected and go to Photos and then to Edge and select an edge and

select the first option.  You may need to expand your vellum box since the Edge feature shrinks it a

little.

Gradient: To have a dimensional look to your text and word embellishments, try the Gradient feature

from the Tool menu.  Play with one color and then two.  (You'll need to "flatten" your text first, so

make sure your text is the way your want it before you flatten it from the layout menu.) 



Page 4

Photo Enhancing:   I love all the ways to "fix" the coloring of my photos.  My latest, is using the

Curve feature.   Click on your photo, select Enhance, Curve and drag the line around and see what

comes alive.  It's fun.   I usually select Photo, Color first to see what that does and then go into

Enhance to try the other things.   Of course, I try to do these things in Memory Manager first.

Viewing your double page spreads:  If you want to see what the double page spreads will look like, 

Save the book, then go to the Home tab and select Order.  It's so fun to go through your book!

Labeling the Spine of the Storybook

If you’d like to have a date and/or name on the spine of your Storybook, you’ll choose Cover from the

Home Menu.  Then go to View and then click on Spine.  Now create a text box.   In the text box section

on the top of your screen, I select the center grid so that the text will be centered.  After the text box is

created, I go to Layout, and then select the rotate that is a 90 degree clockwise (the far right).  Now it's

rotated vertically and I can position it on the spine where I'd like.

Adding Elements to the Embellishment File

The first thing is to go into My Stuff either from the Home Page or clicking on Organize on the 

lower right hand corner when in Storybook and then selecting My Stuff.   

You will need then click on File, Add Collection and then give the Collection a name.  Some that 

I have made are Buttons & Dots, Corners & Tags, Metal, Sports, Baby, etc.

Then when you’re on a page and you see a fun tag, grommet, or label, right click on the element 

and select Save Selection. Go to the location of where the files are (for example on my computer 

it would be C:\Users\Madelyn\Creative Memories\My Scrapbook Stuff\Buttons and 

Dots\Scraps) and give the embellishment a name.  I like to name it from the package I got it from 

and then the color, so like Little Girl Pink Butterfly.  Once you save it, it should appear in the 

embellishment right away.  If not, you might need to exit Storybook and then go back in.

How to create a postcard, invitation or announcement using Storybook Creator Plus

1. In Storybook Creator Plus on the Home Page, choose Create a New Project. 

2. Choose one of the 4x6 options (I like landscape) or choose Custom and make the size you want.  

3. Select Blank and then press Next.

4. Name your file.  I like 4x6 Cards--Landscape so that I can go back to that file any time I need to

create another card. 

5. Now play, play, play!  There are lots of digital papers and embellishments to choose from.  And

depending on the paper, you can either make it the background or add to page with a right click

and adjust up, down, left or right.

6. When you're done, go to Home and Save.   Then choose Save Pages As.  At the top of the screen it

will tell you what folder it is being saved in, or you can browse to a new location.  Select if you

want all the pages, the current page, or selected pages.   

7. Click Save and now you have a photograph on your desktop that you can put on a CD, or upload to

be printed. 
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TO BACKUP STORYBOOKS:

Please get in a habit of backing up your Storybooks.   

The simplest way to do this is from the Home menu. Click on Save and then choose Save As.  You will

need to give your storybook a different name (and preferably on an external hard drive).   This will take

a few minutes.   Make sure from then on that you’re opening your originally named Storybook.  And

repeat the above process every time you’ve make a lot of changes.   It will ask if you want to replace it

and say yes.

Here is another option to saving your file:

When you Open a Project when in Storybook, it will show you where on your computer the storybooks

are located.   

8. On my computer, I have Vista, they are located at: C:\Madelyn\Documents\Creative Memories\Storybooks 

9. With Windows XP they are usually at: C:\My Documents\Creative Memories\StoryBooks

Once you've located the directory, go to the storybook you want to backup.  Right click on the 

Storybook and select COPY.   

Then go to the Drive or the Directory where you want to copy the Storybook (preferably an extended

drive)  Right click and select PASTE.    This will take a few minutes to Copy.   Please have me show

you how to update this as you go along in your project.

TO DELETE STORYBOOKS:

When you Open a Project in Storybook, it will show you where on your computer the storybooks are

located:

10. On my computer, I have Vista, they are located at: C:\Madelyn\Documents\Creative Memories\Storybooks 

11. With Windows XP they are usually at: C:\My Documents\Creative Memories\StoryBooks

Once you've located the directory, go to the storybook you want to delete.  Right click on the 

Storybook and select DELETE.  You will be asked if you want to move it to the recycle bin and 

select Yes.    FYI: Anytime you want to permanently delete a file and not have it go to the recycle 

bin, use the shift key along with the delete key on your keyboard.  You will be asked if you want 

to permanently delete the file.

DELETING PICTURES OUT OF FILES OR OFF OF YOUR DESKTOP

Once you are confident your photos are within Memory Manager or Storybook, go to where the 

photos are located on your computer or desktop.  Select the photos you want to delete using the 

shift and ctrl keys and then use the shift and delete keys on your keyboard to permanently delete 

the photos.  This way you won’t fill up your hard drive by them going to the recycle bin.


